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Introduction

This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration

This section shows the types of External 

Devices which can be connected and SIO 

type.

"1 System Configuration" (page 3)

2 Selection of External Device

Select a model (series) of the External 

Device to be connected and connection 

method.

"2 Selection of External Device" (page 5)

3 Example of Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device.

"3 Example of Communication Setting" 
(page 6)

4 Setup Items

This section describes communication 

setup items on the Display.

Set communication settings of the Display 

with GP-Pro Ex or in offline mode.

"4 Setup Items" (page 10)

Operation
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1 System Configuration

The system configuration in the case when the External Device and the Display are connected is shown.

 Connection Configuration

• 1:1 Connection

• 1:n Connection

Series CPU Link I/F SIO Type Setting Example

SPH

SPH200
(NP1PH-08 / 
NP1PH-16)

NP1L-ET1

Ethernet (TCP)

"Setting Example 1" 
(page 6)

SPH2000
(NP1PM-48R)

NP1L-ET1
"Setting Example 1" 
(page 6)

SPH2000
(NP1PM-48E / 
NP1PM-256E)

Ethernet port on CPU Unit
"Setting Example 2" 
(page 8)

NP1L-ET1
"Setting Example 1" 
(page 6)

SPH300
(NP1PS-32 / 
NP1PS-32R / 
NP1PS-74 / 
NP1PS-74R / 
NP1PS-117 / 
NP1PS-117R / 
NP1PS-245R)

NP1L-ET1
"Setting Example 1" 
(page 6)

Display
External Device

HUB

The max number: 16

Display
External Device External Device

HUB
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• n:1 Connection

• n:m Connection

• A maximum of 8 Displays can be connected to one Ethernet unit.

• A maximum of 10 Displays can be connected to one CPU unit.

• When using multiple CPU units and Ethernet units simultaneously, a maximum of 56 Displays 

can be connected. The greater the number of Display connected, the more the communication 

load increases.

• When 2 or more displays are connected to one External Device, the error below may be 

displayed when 2 or more Displays are activated simultaneously.

"Error has been responded for initial communication command (Error Code:[Hex])"

If an error occurs, the error will automatically recover after a certain period of time has passed 

and normal communication will resume.

The max number: 56

Display
External Device

Display

HUB

DisplayDisplay

HUB

External Device External Device

56 Displays maximum per 1 External Device 16 External Devices maximum per 1 

Display
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to connect. Select "Fuji Electric Co., Ltd.".

Series

Select the External Device model (series) and the connection method. Select "MICREX-SX 
Series Ethernet".
In System configuration, make sure the External Device you are connecting is supported by 
"MICREX-SX Series Ethernet".

"1 System Configuration" (page 3)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

• For the port number, set the value that "251" is added to the set port number with External 

Device.

For example, if "773" is set to the port number with External Device, set "1024" to the port 

number of Device Setting.
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 Settings of External Device

Use the ladder software SX-Programmer Expert (D300win) for communication settings. 

Please refer to the Micrex-SX Series D300Win users manual by Fuji Electric Co., Ltd. for more details.

1 Start up the D300win.

2 Select [New Project] from the [File] menu and select template of using CPU from the New Project dialog.

3 Double click [System Definition] of the project tree to display the system definition screen.

4 Select [Insert] from the displayed menu indicated after right-clicking the CPU.

5 Select Ethernet interface module to be used from [Outline Specification] of the displayed [Module insert] dialog 

box and register it to the system definition.

6 Right click Ethernet interface module and select [Properties] from the displayed menu.

7 Click [Parameter] of the [Module properties] dialog box.

8 Select [IP Address] tub of [Ethernet Parameter] dialog box.

9 Input IP address and subnet mask as shown below in [IP Address].

10 Select [Detail Setting] of [Ethernet Parameter] dialog box.

11 Select [Self port standard No.] and input "773" to the port number above Ethernet interface module.

12 Select [Exit] from [File] menu on the system definition screen.

13 Select [Make] from [Build] menu and compile the project. 

14 Select [Project Control] from [Online] menu and click [Download].

15 Select all items to be downloaded and click [OK].

16 After download is executed normally, click [Reset].

Now communication setting is completed.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet mask 255.255.255.0

• For the port number of Device Setting for GP-Pro EX, set the value that "251" is added to the 

set port number.

For example, if "773" is set to the port number, set "1024" to the port number of Device 

Setting for GP-Pro EX.
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

• For the port number, set the value that "251" is added to the set port number with External 

Device.

For example, if "773" is set to the port number with External Device, set "1024" to the port 

number of Device Setting.
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 Settings of External Device

Use the rotary switch of Ethernet port on CPU unit and the ladder software SX-Programmer Expert (D300win) for 

communication settings. 

Please refer to the Micrex-SX Series D300Win users manual by Fuji Electric Co., Ltd. for more details.

Rotary Switch Settings

Set "0" to the rotary switch of Ethernet port on CPU

Ladder Software Setting

1 Start up the D300win.

2 Select [New Project] from the [File] menu and select template of using CPU from the New Project dialog.

3 Double click [System Definition] of the project tree to display the system definition screen.

4 Select [Properties] from the displayed menu indicated after right-clicking the CPU.

5 Click [Parameter] of the [Module properties] dialog box.

6 Select [IP Address/Gateway Setting] tub of [CPU Parameter] dialog box.

7 Input IP address and subnet mask as shown below in [IP Address/Gateway Setting].

8 Select [Detail Setting] of [IP Address/Gateway Setting] tub.

9 Select [Self port standard No.] and input "773" to the port number of Ethernet port above CPU unit.

10 Select [Exit] from [File] menu on the system definition screen.

11 Select [Make] from [Build] menu and compile the project. 

12 Select [Project Control] from [Online] menu and click [Download].

13 Select all items to be downloaded and click [OK].

14 After download is executed normally, click [Reset].

Now communication setting is completed.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet mask 255.255.255.0

• For the port number of Device Setting for GP-Pro EX, set the value that "251" is added to the 

set port number.

For example, if "773" is set to the port number, set "1024" to the port number of Device 

Setting for GP-Pro EX.
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Example of Communication Setting" (page 6)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set the Display’s IP address in offline mode.

Cf. Maintenance/Troubleshooting Guide "Ethernet Settings"

Setup Items Setup Description

Port No.
Use an integer from 1024 to 65535 to enter the port No. of the Display. When you check 
the option of [Auto], the port No. will be automatically set.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"
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 Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

Setup Items Setup Description

IP Address

Set IP address of the External Device.

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

Port No.

Use an integer from 251 to 65535 to enter the port No. of the External Device.

• For the port number, set the value that "251" is added to the set port number with 
External Device.
For example, if "773" is set to the port number with External Device, set "1024" to the 
port number of Device Setting.

Use Valiable Data
Put a check in the box when using variable data, and select variable data.

"5.4 When Using a Variable" (page 33)
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4.2 Setup Items in Offline Mode

 Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode 

or about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

Port No.

Set the Port No. of  the display. Select either of [Fixed] or [Auto]. 
When you select [Fixed], use an integer from 1024 to 65535 to enter the port No. of the dis-
play. When you select [Auto], the port No. will be automatically assigned regardless of the 
entered value.

Timeout (s)
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send (ms)
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.
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 Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device Settings].

Setup Items Setup Description

Device/PLC Name
Select the External Device for device setting. Device name is a title of External Device set 
with GP-Pro EX.(Initial value [PLC1])

IP Address

Set IP address of the External Device.

Check with a network administrator about IP address. Do not set the duplicate IP address.

Port No.

Use an integer from 251 to 65535 to enter the port No. of the External Device.

• For the port number, set the value that "251" is added to the set port number with 
External Device.
For example, if "773" is set to the port number with External Device, set "1024" to the 
port number of Device Setting.
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5 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

Enter the External Device address in the dialog below.

 When [Addressing Mode] is "Direct"

1 Enter [SX No.] (Input/Output Memory) or [CPU NO.] (Standard/Retain/System Memory).

2 Select a device.

3 Enter the address.

• When the communication unit and the Input/Output unit are used at the same time, Input/

Output Memory cannot be used.

For address settings in GP-Pro EX, use Standard Memory and synchronize the Standard 

Memory address with Input/Output Memory address in External Device.

1

2

3
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 When [Addressing Mode] is "Variable"

1 Select a worksheet.

2 Enter the address.

3 When inputting a bit address, select the bit position of bit address.

4 Variable data is displayed. The address can be entered by double-clicking the displayed variable.

"  Making New Variable Data" (page 38)

• The variables where derived data type of 3 or more hierarchies are defined will not be 

displayed.

1

2 3

4
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 Ladder Software

There are SX-Programmer Expert (D300win) and SX-Programmer Standard in the ladder software to be used for 

setting the External Device. The device name differs respectively as follows.

Device Name
SX-Programmer Expert 

(D300wIn)
SX-Programmer Standard

I/O Memory
Input %I X

Output %Q Y

Standard Memory (fast) %MW1.0  -  %MW1.2047 WM0 - WM2047

Standard Memory*1

*1 The number of device items can be increased or decreased by the ladder tool.  This table                
shows the number of default items.

%MW1.2048 -  %MW1.262143 WM2048 -  WM262143

Retain Memory*1 %MW3.0  - %MW3.260095 WL0 -  WL260095

System Memory %MW10.0 - %MW10.511 WSM0  -  WSM511
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5.1 SPH200

 NP1PH-08

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 - 
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.00000.00 -
%MX.1.04095.15

%MW.1.00000 -
%MW.1.04095

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -
%MX.3.2047.15

%MW.3.0000 -
%MW.3.2047

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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 NP1PH-16

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 -
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.00000.00 -
%MX.1.08191.15

%MW.1.00000 -
%MW.1.08191

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -
%MX.3.4095.15

%MW.3.0000 -
%MW.3.4095

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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5.2 SPH2000

 NP1PM-48R / NP1PM-48E

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 -
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.00000.00 -
%MX.1.65535.15

%MW.1.00000 -
%MW.1.65535

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -
%MX.3.8191.15

%MW.3.0000 -
%MW.3.8191

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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 NP1PM-256E

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 -
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.00000.00 -
%MX.1.1703935.15

%MW.1.00000 -
%MW.1. 1703935

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -

%MX.3. 262143.15
%MW.3.0000 -
%MW.3.262143

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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5.3 SPH300

 NP1PS-32 / NP1PS-32R

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 -
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.0000.00 -
%MX.1.8191.15

%MW.1.00000 -
%MW.1. 8191

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -
%MX.3. 4095.15

%MW.3.0000 -
%MW.3.4095

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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 NP1PS-74 / NP1PS-74R

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 -
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.0000.00 -
%MX.1.32767.15

%MW.1.00000 -
%MW.1. 32767

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -
%MX.3. 16383.15

%MW.3.0000 -
%MW.3.16383

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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 NP1PS-117 / NP1PS-117R

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 -
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.0000.00 -
%MX.1.131071.15

%MW.1.00000 -
%MW.1. 131071

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -
%MX.3. 32767.15

%MW.3.0000 -
%MW.3.32767

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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 NP1PS-245R

 This address can be specified as system data area.

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.000.00 -
%IX.511.15

%IW.000 -
%IW.511

*1

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

Output Memory
%QX.000.00 -
%QX.511.15

%QW.000 -
%QW.511

*1

Standard Memory
%MX.1.0000.00 -
%MX.1.262143.15

%MW.1.00000 -
%MW.1. 262143

*2  *3

*2 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*3 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.0000.00 -

%MX.3. 130047.15
%MW.3.0000 -
%MW.3.130047

*2  *3

System Memory
%MX.10.000.00 -
%MX.10.511.15

%MW.10.000 -
%MW.10.511

*2

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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5.4 When Using a Variable

 Usable Device

The table below shows the Base Data Types of usable Variables.

Data Type Bit Address Word Address 32bits Remarks

BOOL

Single 
Var

<VARNAME>

- - *1  *2  *3

*1 <VARNAME>: This is the complete "Variable" name including "Worksheet" name and "Structure"           
name if it is a sub element of a structure. Maximum 255 characters including delimiters (‘.’) and                
address part (e.g. bit position and array information).

e.g. BOOL type single tag in a Global Worksheet:
"CONF.MainResource.Global_Variables.BOOLVAR"

e.g. INT type single tag in a Local Worksheet:
"MainProgram.MainProgramV.INTVAR"

e.g. DINT type bit address: "MainProgram.MainProgramV.DINTVAR.30"
e.g. REAL type 2D array: "MainProgram.MainProgramV.REALARRAY[1].[2]"
e.g. DINT from a TIMER structure: "MainProgram.MainProgramV.TIMERVAR.PRE"
e.g. BOOL from a User Defined Structure :
                                    "CONF.MainResource.Global_Variables.USERSTRUCTURE_

                         A.MYTIMER.EN"

• You cannot start names with any of the following text:
LS, USR, SCR, PRT

*2 Array dimensions: Up to 2D arrays can be created. When a "Variable" is an array, the size is defined.

Range of array elements: -32728 to 32767

Number of array elements: 32768

Usable memory size for 1 variable: Less than 65535 words

*3 BOOL type arrays: The External Device address must start on bit 0. e.g. %MX1.100.0

1D 
Array

<VARNAME>.[0] to 
<VARNAME>.[x-1]

2D 
Array

<VARNAME>.[0].[0] to 
<VARNAME>.[x-1].[y-1]

INT
UINT
WORD

Single 
Tag

< VARNAME >.00 to 
< VARNAME >.15

< VARNAME >

*1  *21D 
Array

< VARNAME >.[0].00 to 
< VARNAME >.[x-1].15

< VARNAME >.[0] to 
< VARNAME >.[x-1]

2D 
Array

< VARNAME >.[0].[0].00 to 
< VARNAME >.[x-1].[y-1].15

< VARNAME >.[0].[0] to 
< VARNAME >.[x-1].[y-1]

DINT
UDINT
DWORD
REAL
TIME

Single 
Tag

< VARNAME >.00 to 
< VARNAME >.31

< VARNAME >

- *1  *21D 
Array

< VARNAME >.[0].00 to 
< VARNAME >.[x-1].31

< VARNAME >.[0] to 
< VARNAME >.[x-1]

2D 
Array

< VARNAME >.[0].[0].00 to 
< VARNAME >.[x-1].[y-1].31

< VARNAME >.[0].[0] to 
< VARNAME >.[x-1].[y-1]

STRING
Single 
Tag

- <VARNAME> - *1   *4

*4 Cannot be used with array access. "STRING" cannot be used as a part of the structure.
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To use a variable and Derived Data Type that were set by D300win with the GP-Pro EX, CSV file and IEC file 

need to be imported.

CSV file and IEC file are exported by D300win.

Imported data is saved as variable data.

• The following derived data types are available for address input with GP-Pro EX.

• Array data type

One-dimensional array

Two-dimensional array (an array of arrays)

• Structural data type

Structure

Array of structure

Structure of array

Structure of structure

• When specifying the address of the External Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the MICREX-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

• Defined variable data can be used only with this driver. Therefore, variable data defined with 

other drivers cannot be used with this driver. In the same way, variable data defined with this 

driver cannot be used with other drivers.

• When IEC file meets any of the following conditions, it cannot be imported. Correct 

inappropriate conditions and then import the file.

• There are two or more definitions or keywords (e.g. TYPE and END_TYPE) in 1 row. 

(When a line break is inserted in the comment, the case is recognized that there are two or 

more definitions or keywords in 1 row.)

• There is a structure where array variables are defined.

• There is an Alias of basic data type.
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 Setting Items of [Variable] List Dialog Box

Enter the file name of the variable data.

Select data type to be listed.

Select a worksheet where the variable is registered.

Operation buttons. After selecting the data in the 
[List], adding, deleting, or editing can be executed 
here.
[View] indicates the content of data.
[Import] imports variables and data type.

The cursor is moved to the variable, and data type 
and comments are displayed.

Variable, data type, array, and worksheet that are 
registered in the variable data are displayed.
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 Importing Variable and Data Type

1 Set variable, data type, array, and worksheet with D300win. 

Version of D300win that is supported is V3.1.0.0 or later.

2 Select [Export] from the [File] menu and select the data to be exported. 

Data below needs to be exported.

3 Make [Individual Device Settings] dialog box displayed with the GP-ProEX, and put a check to [Use Variable 

Data]. Then click [New].

4 Enter the name of variable data to save the setting in the [Variable Data Name].

Data to be exported Description File type

Cross reference Variable and worksheet CSV

IEC 61131-3 Data type and array IEC
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5 Click [Import] to import CSV file and IEC file that were exported in the Procedure 2.

Import IEC file first followed by CSV file.

6 Confirm the registered data and click [OK].

• When CSV file including variable with the user-defined data type is imported prior to IEC file, 

an error, "Unknown Data Type was found" is displayed and variable is not imported. Import 

IEC file first in order to register the user-defined data type.

• Arrays, structures and parameters whose name length exceeds 30 single-byte characters 

cannot be imported. Set the name length to 30 single-byte characters or less and then import 

them.
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 Making New Variable Data

If variable data is not imported, make variable data using the following procedures.

Making a Worksheet

1 Select "Worksheets" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Worksheet] dialog box.

3 Enter "Configuration", "Resource/Program" and "Worksheet" and click [OK].
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Making Variable

1 Select "Variables" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Variable] dialog box.

3 Enter "Name", "Data Type", "Address" and "Comment" and click [OK].

• To add a variable, the worksheet needs to be set.

Make the worksheet before making the variable.

"  Making a Worksheet" (page 38)
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Making Derived Data Type

1 Select "Structures" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Derived Data Type (Structure)] dialog box.

3 Enter "Derived Data Type Name" and "Name" and "Data Type" of Member included in "Derived Data Type", and 

click [OK].
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Making an Array

1 Select "Arrays" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Derived Data Type (Array)] dialog box.

3 Enter "Array Name", "Data Type", "Start Element" and "End Element" and click [OK].
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6 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

• When using a variable, device code and address code cannot be used.

Device Device Name
Device Code

(HEX)
Address Code

Input Memory
%IX

83 Word Address
%IW

Output Memory
%QX

84 Word Address
%QW

Standard Memory
%MX1

80 Word Address
%MW1

Retain Memory
%MX3

81 Word Address
%MW3

System Memory
%MX10

82 Word Address
%MW10
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7 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

 Error Code Unique for Driver

Item Description

No. Error No.

Device Name
Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.

• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the 

error messages common to the driver.

Error Code Description

0x10 CPU Error: An error occurs in the CPU and a command cannot be executed.

0x11 CPU in operation: Command cannot be executed because CPU is in operation.

0x12
Command cannot be executed: Due to CPU's key switch condition, a command cannot be 
executed.

0x23
During transmission interlocking: Transmission is interlocked due to a loader command from 
another device.

0x28
During command processing: Requested command cannot be executed because other 
command is in process.

0x2B
During other loader processing: Request command cannot be executed because loader is in 
process (program changes).

0x2F
Initialization incomplete: Requested command cannot be executed because system is 
initializing.

0x44 Memory addressing error: Specified address exceeds effective area.

0x45
Memory size over: Address + reading/the number of written words exceeds the effective 
area.

0xA0
Designated command destination error: No module exists at the designated destination 
number.
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 Error Message Unique for Driver

0xA2 No command response: No response data from destination module.

0xA4 SX bus sending error: Error occurred in SX bus, and commands cannot be exchanged.

0xA5 SX bus NAK: NAK occurred in SX bus sending, and commands cannot be exchanged.

Error Code Error Message Description

RHxx128
"(Node Name):The number of specified 
destination module is not existed.(Error 
Code: [Hex])"

It occurs when accessing a non-existing CPU 
No., and SX No.
Designate existing module.

Error Code Description
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